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TrainingCentre 
 Getting Started Guide 

This guide introduces you to TrainingCentre and provides basic information about using 
its many features. For more information about using these features, refer to the online 
Help on your TrainingCentre Web site. 

Refer to the table below to locate the information you need. Feature descriptions and 
step-by-step procedures are grouped under the larger training session tasks you are 
performing, such as scheduling a training session, sharing information, or housekeeping 
and management tasks, such as muting and unmuting microphones. 

Obtaining a User Account 
Once you obtain a user account, you can host training sessions using your training 
session service. You need not obtain a user account to attend training sessions. 

You can obtain a user account in one of two ways: 

 The site administrator for your TrainingCentre Web site can create a user account 
for you. 

 If your site administrator has made the signup feature available, you can sign up 
for an account on your TrainingCentre Web site at any time. 

To obtain a user account using the signup feature: 
1 Go to your TrainingCentre Web site. Your address for your site is usually in the 

following format: 

<your_company> .webex.com 

2 On the navigation bar, expand Set Up. 

3 Click New Account. 

This option is available only if your site has the self-registration feature. 

4 Provide the required information, and then click Sign Up Now. 

Logging In and Out 
You must log in to your TrainingCentre Web site to schedule and start your training 
sessions and access your account features. Your site administrator provides you with 
your user name and default password for your account. 
Note: You do not need to log in to your site to attend a training session, unless the training session host 
specifies that all attendees must have a user account. 

To log in to TrainingCentre: 
1 Go to your TrainingCentre Web site. The address for your site is usually in the 

following format: 

<your_company>.webex.com 
2 On the navigation bar, click Log In. 

3 Provide your user name and password. 

4 Optional. To automatically log in to TrainingCentre whenever you access it, click 
the Remember user name and password check box. 

5 Click Log In. 

To log out from TrainingCentre: 
To log out from your TrainingCentre Web site, on the navigation bar at the top of the 
page, click Log Out. 

 



  

 
 
 
 
 IF YOU HAVE FORGOTTEN YOUR USER NAME OR PASSWORD 
 If you have forgotten either your user name or password, you can quickly obtain it. 

To obtain your user name or password: 

1 On the navigation bar, click Log In. 

2 On the Log In page, click Login Assistance. 

3 Provide your email address, and then click OK. 

Your TrainingCentre Web site immediately sends you an email message containing your account information. 

Setting up TrainingManager for Windows 
TrainingManager is a software program that you install on your computer and use when participating in a training session. 
TrainingManager provides the options that you use to share information—such as presentations and applications—send chat 
messages, send and receive live video, take notes, record a training session, and so on. 

The TrainingManager software provides the work space for your training session. 

SYSTEM REQUIREMENTS 

Your system must meet these requirements for installing Training Manager for Windows: 
 Microsoft Windows 2000 or XP 

 Intel x86 (Pentium 400 MHz +) or compatible processor 

 32 MB RAM (64 MB recommended) 

 Microsoft Internet Explorer 6 or later, Mozilla 1.6 or later, Netscape Communicator 7.x, Firefox 1.0 or later 

 JavaScript and cookies enabled on the Web browser 

 56K or faster Internet connection 

If you want to share a presentation that was created using Microsoft PowerPoint 2002 for Windows XP, an Intel Celeron or 
Pentium 500 MHz or faster processor is highly recommended. However, you cannot share other types of presentation or 
documents unless you either: 

 Sign in to your computer as an administrator before starting or joining a training session for the first time, or 

 Have a Windows NT or 2000 administrator set up your computer for you. 

Subsequently starting or joining an event does not require administrator privileges. 

To set up TrainingManager for Windows: 
1 On the navigation bar, expand Set Up, and then click TrainingManager. The Set Up page appears. 

2 Click Set Up. 

3 If a security dialog box appears, do one of the following: 

- If you are installing TrainingManager on Microsoft Internet Explorer, click Yes. 

- If you are installing TrainingManager on Netscape Navigator, click Grant.  

Setup continues. A progress message box appears, indicating the progress of setup. 

- Once setup is complete, the Setup Complete page appears. 

4 Click OK. 

You can now start, schedule, or join a training session. 

 
 



  

 
 

Browsing the Session Calendar 
The Live Sessions page includes a training session calendar, which provides upcoming, daily, weekly, and monthly views of 
all scheduled or in-progress training sessions on your site, as well as a list of all training sessions being hosted on the current 
date. Using the calendar, participants can: 

 search for a training session 
 obtain information about a training session 
 register for a training session 
 join a training session 

The following figure shows the Daily view of the Live Sessions page. 

 

Joining a Training session 
If a training session host invites you to a training session via email, the invitation email message will include 
information about the training session, instructions for joining the voice conference, and a link that you can click to join 
the training session. 
This example of a training session invitation shows the level of detail included: 
 

 

Click on this link 
to join the 
training session 

 

 

 

 
Tip:  A training session invitation may also include a link that you can click to add the training session to any calendar program that supports the iCalendar 
format, such as Microsoft Outlook or Lotus Notes. 
 

 

 



  

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

You can also join a training session directly from your TrainingCentre Web site or from the host’s Personal Meeting Room 
page. The steps for joining a training session from your site differ, depending on whether the training session is listed or 
unlisted— that is, whether or not the training session appears on the public training session calendar and the host’s Personal 
Meeting Room page. 

Once you join a training session, instructions for joining the voice conference automatically appear on your screen. This 
illustration shows sample instructions for a call-in teleconference. 

 
NOTES: 

 To participate in a training session, you must use TrainingManager. If you have not yet set up TrainingManager on 
your computer, you can do so before joining a training session to avoid a delay. Otherwise, once you join a training 
session, your TrainingCenter Web site automatically sets up TrainingManager on your computer. For more information 
about setting up TrainingManager on your computer, see “Setting up TrainingManager for Windows.” 

 You need not have a user account or log in to your site to join a training session, unless the host has specified that all 
training session participants must have a user account. You need not have a user account or log in to your site to join 
a training session. 

To join a training session from an invitation email message: 

1 Click the link in the message to join the training session. 
2 On the Session Information page that appears, click Join Now. 

Types of Training sessions 
Using TrainingCentre, you can set up a scheduled, instant, or audio only training session. When setting up any type of 
training session, you can specify that it is either listed or unlisted.  

The following table defines each type of training session. 

Session Type Description 
Scheduled A training session that you schedule for a specific date and time, using the Schedule a Training Session wizard. When 

scheduling a training session, you can 
 Specify a recurrence pattern for the training session 
 Schedule and start a training session for another user who has granted you scheduling permission 
 Specify voice conferencing options 
 Send invitations to participants 
 Require attendees to register for a training session, which lets you collect information from attendees and 
enhances the security of your training session 
 Choose which default training session privileges you want attendees to have 
 Choose which training session options you want to turn on or off, such as chat, video, and so on 
 Let attendees join the training session before its scheduled starting time—that is, before you start it 

Choose a presentation or document to share automatically once a participant joins the training session 
Instant An impromptu training session that you set up and start immediately, using the Instant Session page. When setting up 

an instant session, you can specify voice conferencing options only. 
Audio Only A training session that is a standalone teleconference. 
Listed A training session that appears on your Training Center Web site’s calendar and your Personal Meeting Room page. 

Because these pages are publicly accessible, visitors can view lists of training sessions on these pages. 
Unlisted A training session that does not appear on any pages on your Training Center Web site. To join an unlisted training 
 session, attendees must provide the training session number. Your training session service automatically generates a 
unique training session number for each training session that you host. 

 



  

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scheduling a Training Session 
When scheduling a training session, you must specify a training session topic and starting time. You can also specify several 
options to provide security for and to customize your training session.  

You can schedule a training session quickly from the Schedule Training Session page. You can click the Start button at any 
time to start your training session.  

To schedule a training session: 

1 Log in to your Training Center Web site. 
2 On the navigation bar, expand Host a Session to view a list of links. 
3 Click Schedule Training. 
4 Scroll to Session and Access Information, enter your information, and make your selections. 

 

What you can do here 
 Specify whether you are setting up a training session on someone’s behalf and the name of that person. 
 Define a topic for the training session. 
 Set the training session password, if required 
 Specify whether the training session is listed on the training session calendar. To enhance training session security, 
you can opt not to list the training session on the training session calendar. Choosing Unlisted will: 
- Hide information about the training session, such as its host, topic, and starting time 
- Help prevent unauthorized access to the training session 
 Select tracking codes, if your administrator has set them up.  

Tracking codes may identify your department, project, or other information that your organisation wants to associate 
with your training sessions. Tracking codes can be optional or required, depending on how your site administrator 
set them up. 

5 Scroll to Teleconference and make your selections. 

 

 
 
 
 
 
 
 
 

 



  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What you can do here 

 Set up a WebEx integrated teleconference with a toll or toll-free number or use a third-party conferencing service. 
 Opt to have attendees call in to the conference or have them receive a call back. 
 Include an Integrated VoIP conference and a traditional teleconference in your training session. 

Note: You start your Integrated VoIP conference after you start your training session. 

To provide audio during a training session, you can use one of the following voice conferencing services: 

 Integrated call-in teleconference—If your training session service provides toll-free call-in teleconferencing, both a toll-
free number and a toll number are available. The toll number allows participants who cannot call the toll-free number—
such as participants in countries other than the U.S. or Canada—to join the teleconference. 
 Integrated call-back teleconference—A teleconference that a participant can join by providing his or her phone number 
when joining a training session. 
 Third-party or internal teleconference—You can use any third-party teleconferencing service or internal 
teleconferencing system, and provide instructions for joining a teleconference when setting up a training session. Your 
instructions automatically appear in a message box when a participant joins the training session. 
 Integrated VoIP conference—A voice conference in which participants use computers with audio capability to 
communicate over the Internet rather than the telephone system. 

6 Scroll to Date and Time and make your selections. 

 

What you can do here 

 Set the date and time for the training session 
 Select the number of minutes before the training session’s starting time during which attendees can join the training 
session and teleconference. 
 Set an occurrence pattern for the training session. 
 Set the time zone in which the training session time will appear on the calendar. 
 Set the duration for the training session. 

7 Scroll to In-session Hands-On Lab and make your selections. 

 

 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What you can do here 

 Select whether to use a Hands-on Lab during the training session. 
 Check the availability of computers in the Hands-on Lab that you select. 
 Select the number of remote computers to reserve during the training session. 

8 Scroll to Registration and make your selections. 

 
What you can do here 

 Specify whether attendees must register to attend a training session. 
 If attendees must register, select which information attendees must provide on the registration form. 
 Approve registration requests automatically. 

9 Scroll to Invite Attendees and enter information for the attendees you wish to invite. 

 
What you can do here 

 Invite attendees to your training session, by entering their names and email addresses, or selecting them from your 
address book. 
 Enter the number of attendees. 

10 Scroll to Invite Presenters and enter information for the presenters you wish to invite. 

 
What you can do here 

 Invite presenters to your training session, by entering their names and email addresses, or selecting them from your 
address book. 
 Enter the number of presenters. 

11 Scroll to Session Options and make your selections. 

 
 
 
 
 



  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What you can do here 

 Select the training session privileges that attendees have once the training session starts. 
 You can allow attendees to: 
- Save, print, or annotate any shared documents, presentations, or whiteboards that appear in their content viewers. 
- View the list of training session participants. 
- Navigate independently through pages. slides, and whiteboard displayed in their content viewer 
 Select which options, such as chat, video, and recording, are available during the training session. 
 Require attendees to have an account on your TrainingCentre Web site. 
 Specify a URL destination that appears after the training session ends. 
 Specify whether attendees can share UCF rich media files. 
 Specify alerts that play when a participant joins or leaves the teleconference, if you use integrated teleconferencing. 
 Include a message that appears when attendees join the training session.  

Note: A presenter can change the default privileges for all attendees or individual attendees at any time during a training session. 
12 Scroll to Email options and make your selections. 

 
What you can do here 

 Select which invitation, update, registration, or reminder emails to send to attendees, presenters, or the host. 
 Modify invitation, update, registration, or reminder emails. 
 Select when to send the reminder emails. 

13 Scroll to Session Information and make your selections. 

 
What you can do here 

 Type an agenda or a description, which the attendees can view before the training session starts. 
 Upload a photo to the Session Information page. 
 Automatically show a document or presentation to participants once they join the training session. 
 Select whether the Quick Start page will appear upon joining a training session or a breakout session. 

14 Scroll to Course Material to add files for your training session. 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What you can do here 
 Upload a file to My Folders on your TrainingCentre Web site. 
 Publish course material for participants to download prior to the training session. 

15 Scroll to Tests.  

 
What you can do here 

 Ensure that registration is enabled—a requirement if tests will be used during the training session. 
 Learn how to add a test to your training session once it has been scheduled. You can add a test from the confirmation 
page that appears, or from the Session Information page.  

16 Start or schedule the training session: 
- If the training session’s starting time is the current time, click Start to start the training session. 
- If the training session’s starting time is after the current time, click Schedule.  

The Session Scheduled page appears, confirming that you set up the training session successfully. You also receive a 
confirmation email. 

Adding a Test  
To test attendees, you must add tests to the training session that they will be attending.  
Before you can add tests, do the following to turn on the Testing feature: 

 Schedule, but do not start, a session. 
 Require attendee registration for the session.  

To require attendee registration, select Attendee Registration when scheduling or updating the session.  

To add a test to a scheduled training session: 

1 Do one of the following: 
- From the Session Scheduled page, click Add a test. 
- From the Session Information page for the session, click Add New Test. 

2 On the Add Test page, select one of the following and click Next: 
- Create a new test 
- Copy an existing test from the Test Library. 
Select the test you want to copy from the Test Library and click Next. 
- Import test questions from saved test or poll questionnaire (*.atp or *.wxt file.) 
Select the file and click Next. 

3 Compose or edit the test, and click Save. 
4 Specify delivery options, such as the test date and time limit, and click Save.  
The Manage Test page appears. The following figure shows an example of the Manage Test page. 

 

 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 To return to the Session Information page, click Done.  
Follow the same instructions to add multiple tests to a session.  

To create a test: 

1 Do one of the following: 
- On the Test Library page, click Create New Test. 
- On the Session Information page, click Add New Test. Select Create a new test, and click Next.  

The Create Test page appears. 
2 Specify the following: 

- Test title and description 
- Maximum score — Select the check box and type the score in the text box to specify the maximum score an 

attendee can receive. 
- Grade — Select the check box to assign a grade based on the attendee’s scores. Click the Specify Grades link to 

specify a grading scale. 
- Display question — Select one of the following:  

o All questions in one page 
o One question per page  

3 Click the Insert Question link to add a question or instructions to the test.  
The Add Question window appears. 
4 Click the Question Type drop-down list. 
5 In the drop-down list, do one of the following: 

- Choose Instructions to add instructions in the beginning of the test, and click Save. 
- Choose one question type, compose the question, specify the correct answers, and click Save. 

6 Follow the same instructions to add additional questions to the test. 
7 In the Scoring Panel area for each question, specify a score for the correct answer and optionally type scoring 

guidelines or comments for the person who will score the test. 
8 To rearrange questions, click the Move Up or Move Down links. To edit a question, click Edit. 
9 Click Save.  

To add a test from the Test Library: 

1 Do one of the following: 
- From the Session Scheduled page, click Add a test. 
- On the Session Information page, click Add New Test. 

2 Select Copy an existing test from the Test Library, and click Next. The Select from Test Library page appears. 
3 Select a test and click Next. The Edit Test page appears. 
4 Make any changes if necessary and click Save. 
5 Specify test delivery options and click Save.  
The Manage Test page appears. 

 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 Make any changes if necessary and click Done.  
The Session Information page appears, with the title of your test included in the Title section.  

To start an in-session test: 

1 After the session starts, choose Testing in the drop-down list on the Participants panel. 
2 Select the title of the test, and then click Launch for All. 
3 On the page that appears, click Start Test.  

SCORING AND GRADING ANSWERS FOR A TEST  

TrainingCentre automatically checks attendees’ answers against the correct answers you specified when creating the test 
and then scores the results. If a test contains essay or fill-in-the-blanks questions, you must manually review and score the 
test. A complete score is unavailable until you finish scoring the essay or fill-in-the-blanks questions.  

To score the answers for a test: 

1 From the Session Information page, in the Test section, select the test title and click View. The Manage Test page 
appears. 

2 In the Student Answers section, click View and Score Answers. 

The Submitted Tests page appears. This page lists attendees who have submitted their tests and attendees who have 
received their scores and grades, if assigned. You can also view the questions and grading scale, if specified.  

 
3 To score an attendee’s test, click the Score Answers link for the attendee or click the attendee’s name.  

The Score Submitted Answers page appears. All answers, except for essay questions, are automatically scored. A 
partial score appears in the Results area. Although fill-in-the-blanks answers are scored automatically, you may want to 
review them and change the scores, if necessary. 

4 Review the essays or fill-in-the-blanks answers that need manual scoring, and specify the scores for the essays. 
- To quickly go to a question that needs manual scoring, go to the Unscored questions section, choose a question in 

the drop-down list, and click Go. 
- To change the score for a fill-in-the-blanks answer, select correct or incorrect for the question. Clicking Save 

updates the score. 
5 Optionally type comments for the attendee. 
6 Click Save to update the score or your comments. 

The test results are updated on the View Test Results page. If you have specified to send grade reports to attendees, the 
attendee receives the update via email.  
 

 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting an Instant Session  
You can start a training session at any time, without the need to schedule it first. When starting an instant training session, 
you can also set up an integrated voice conference. Once you start the training session, you can send invitation email 
messages to attendees, if necessary.  

To start an Instant Session: 

1 Log in to your TrainingCentre Web site. 
2 On the Training Center navigation bar, expand Host a Session, and then click Instant Session. 
3 Specify information about the training session. 
4 Click Start Session. 
5 Optional. Send invitations to your training session in one of the following ways: 

- On the Participant menu, point to Invite, and then choose By Email. 
- On the Participants panel, click the Invite button, and then enter an email address on the window that appears. 

Sharing Options  
MeetingCentre provides you with a variety of options for sharing information in a training session. The following table 
describes the advantages and disadvantages among these options. 

Sharing Option Advantages Disadvantages 
Presentation and 
Document Sharing 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Is faster and more bandwidth efficient than 
application or desktop sharing. 
 Is ideal for sharing presentations or documents 
that you do not want to edit during the training 
session. 
 Lets you and participants annotate content. 

 Does not let you edit the content 
during the training session 

Application Sharing  Lets you edit the content of any presentation or 
document open in the application. 
 Lets you grant attendees control of the 
application. 
 Is ideal for software demonstrations. 
 Lets you and attendees annotate the 
application and documents that are open in it. 

 Requires more bandwidth than 
presentation or document 
sharing. 

Desktop Sharing  Lets you quickly share multiple applications at 
once. 
 Lets you show any part of your desktop, 
including file directories. 
 Lets you grant attendees control of your 
desktop, access files, and run applications. 
 Lets you and attendees annotate your desktop 
and any applications. 

 Requires the most bandwidth 
among sharing options.  
 Lets an attendee with remote 
control access any part of your 
computer and modify any files, 
which may be a security 
concern. 

Web Browser Sharing  Lets you guide attendees to various Web pages 
and sites on the Web. 
 Lets you grant attendees control of your Web 
browser. 
 Lets you and attendees annotate Web pages. 

 Does not display media effects 
or transmit sounds on Web 
pages.  
 Does not let attendees interact 
with Web pages independently. 

Web Content Sharing  Displays media effects and transmits sounds 
on Web pages. 
 Lets attendees interact with Web pages 
independently. 

 Does not let you guide 
participants to other Web pages 

 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sharing Documents and Presentations 
You can share one or more presentations or documents you have created using word processing, presentation, or graphics 
programs. Document and presentation sharing is ideal for presenting information that you do not need to edit during the 
training session, such as a slide presentation. 

Attendees view the shared document or presentation in their content viewers. 

They do not need to have the applications used to create the documents available on their computers. Attendees can also 
view any animation and transition effects on shared Microsoft PowerPoint slides. 

Once a training session starts, you can open a document or presentation to share. You do not need to select it or “load” it 
before the training session. 

While sharing a document or presentation, you can: 

 Make annotations 
 Use a pointer to emphasize text or graphics 
 Save it to a file 
 Print it 
 Display it at various magnifications, in miniature (thumbnails), and in a full-screen view 
 Synchronize all participants’ displays with the display in your content viewer 

At any time during a training session, you can grant attendees privileges that allow them to annotate, save, print, and display 
different views of shared presentations or documents. 

To share a document or presentation: 

1 On the Share menu, choose Presentation or Document. The Share Presentation or Document dialog box appears. 
2 Select the document or presentation that you want to share. 
3 Click Open. 

The shared document or presentation appears in the content viewer, as in the example below: 

 
TIP: For tips that can help you to share documents and presentations more effectively, see “Tips for sharing software.”  
 

 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ACCESSING TOOLS FOR SHARING 

As you start sharing documents and applications during your training session, tools are available at your fingertips. 

In this example, the host has opened a presentation to share with training session participants. 

Notice the changes in the window. You now have access to: 

 Annotation tools for highlighting and referring to elements in the presentation or application you are sharing 
 View tools for displaying document and presentations in different ways, such as showing thumbnails of the pages  
 Previous and Next buttons, for moving around in a document 
 Viewer tabs, which appear for each open document or whiteboard—you can rename or change the order of the
tabs by right-clicking each tab’s name 

 

ANNOTATION TOOLS 
 
 

Annotation Colour tool Rectangle tool Text tool 

 
 
 

 Line tool Highlighter tool 

Tool 
Pointer

Text 

Line 

Rectan

Highlig

Annota

Eraser 

 

Eraser tool 
Pointer tool

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Description 
 Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and 

annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a 
red “laser beam,” click the downward-pointing arrow. Clicking this button again and then clicking the Close button 
turns off the pointer tool. 
Lets you type text on shared content. Attendees can view the text you have entered after you type it and click your 
mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this 
button again and then clicking the Close button turns off the text tool. 
Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking 
this button again and then clicking the Close button turns off the Line tool. 

gle Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-
pointing arrow. Clicking this button again and then clicking the Close button turns off the Rectangle tool. 

hter Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. 
Clicking this button again and then clicking the Close button turns off the Highlighter tool. 

tion Colour Displays the Annotation Colour palette, Select a color to annotate shared content. The Annotation Colour palette 
closes. 
Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. 
For more options, click the downward-pointing arrow. Clicking this button again and clicking the Close button turns 
off the eraser tool. 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Tool Description 
Standard View / View 
Thumbnails 

Clicking Standard View displays the shared content as you would normally view it. To display 
thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click 
View Thumbnails. This tool helps you locate a page or slide quickly.  
Click Standard View to return to normal viewing of the shared content. 

Full-Screen View Displays shared content in a full-screen view. Helps you to ensure that participants can view all 
activity on your screen. Also helps to prevent participants from viewing or using other applications 
on their screens during a presentation.  
Click ESC to return to the content viewer. 

Zoom In / Zoom Out Lets you display shared content at various magnifications. Click this button, and then click the 
page, slide, or whiteboard to change its magnification. For more magnification options, click the 
downward-pointing arrow. 

Synchronize Displays 
for All 

For presenters, synchronizes all participants' displays with your display. Helps to ensure that all 
participants are viewing the same page or slide, at the same magnification, as in your display. 

Sharing Whiteboards  
Sharing a whiteboard allows you to draw objects and type text that all attendees can see in their content viewers. You can 
also use a pointer to emphasize text or graphics on a whiteboard.  

While sharing whiteboard, you can: 

 Display it at various magnifications, in miniature (thumbnails), and in a full-screen view 
 Save it 
 Print it 
 Synchronize attendees’s displays with the display in your content viewer  

If you grant annotation privileges to attendees, you and attendees can draw and type on a whiteboard simultaneously. You 
can also allow attendees to save, print, and display different views of shared whiteboards.  

To share a whiteboard:  

On the Share menu, choose Whiteboard.  

When sharing a whiteboard: 

 You can add multiple pages to a shared whiteboard. For details, consult the users’ guide or online Help. 
You can share multiple whiteboards. For each whiteboard that you share, Training Manager creates a new Whiteboard tab in 
the content viewer.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SHARING MULTIMEDIA IN A WEBEX TRAINING SESSION  

During a training session, you can share the following types of media files in the content viewer: 

 WebEx Recording Format (WRF) files 
 video files 
 audio files 
 Flash movie and interactive Flash files 
 Web pages  

You can share media files in either of two ways: 

 In a Microsoft PowerPoint presentation—You can share media files that play on Microsoft PowerPoint slides. Using the 
WebEx Universal Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert UCF media objects into 
your slides. Depending on the options you choose in the toolkit, the media object can either: 
- link to a media file that resides on your computer, another computer on your local network, or a remote server 
- contain a media file as part of your presentation file  
You can download the Universal Communications Toolkit from your TrainingCentre  web site. For information about 
using the Universal Communications Toolkit, refer to the guide Getting Started with WebEx Universal Communications 
Toolkit, which is available on your TrainingCentre Web site. 
 As a standalone file—You can share a media file directly in the content viewer. TrainingManager creates a UCF media 
object for the file automatically, which appears in the content viewer.  

A UCF media object contains options and controls that you can use to display or manipulate its associated media file.  
For more information about how UCF works, consult the TrainingCentre User’s Guide or online Help.  

GRANTING DOCUMENT, PRESENTATION, AND WHITEBOARD SHARING PRIVILEGES  

By default, only the presenter can share a document, presentation, or whiteboard during a meeting. However, you can allow 
all attendees or individual attendees to share their own presentations or documents or interact with pages, slides, and 
whiteboards that others share. You can also remove these sharing privileges from attendees at any time.  

To specify attendee privileges for shared content in the content viewer: 

1 In the Session window, on the Participant menu, choose Assign Privileges. The Attendee Privileges dialog box 
appears. 

2 Do one of the following: 
- To grant privileges to or remove them from all attendees at once, in the pane on the left, select All Attendees. 
- To grant privileges to or remove them from an individual attendee, in the pane on the left, expand All Attendees, and 

then select the attendee's name. 
3 Under Document, select or clear the check boxes for any of the following sharing privileges that you want to grant to 

or remove from all attendees, respectively: 
- Save 
- Print 
- Annotate 

4 Under View, select or clear the check boxes for any of the sharing privileges that you want to grant to or remove 
from all attendees, respectively: 

- Attendee list 
- Any document 
- Thumbnails 
- Any page 

5 Under Training session, select or clear the Share documents check box to grant to or remove the privilege from all 
attendees, respectively. 6 Click OK. 

 
 
 
 
 
 
 
 



  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sharing Software  
When you share software, attendees can follow all actions that you take. You can also annotate the software, or let an 
attendee annotate it or control it remotely.  

You can share these types of software with attendees: 

 Applications on your computer 
 Your computer’s desktop 
 Web browsers 
 Remote computers, if you installed the Access Anywhere Agent on the computer  

To share an application: 

1 On the Share menu, choose Application.  
The Share Application dialog box appears, showing a list of all applications currently running on your computer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2 Optional. To view a list of applications that are installed on your computer, but not currently running, click View 
Application.  
Use this option to locate an application you want to share, but are not currently using.  

3 In the list, select the application that you want to share. 
4 Click Share.  

Your application appears in a sharing window on attendees' screens.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LETTING AN ATTENDEE REMOTELY CONTROL SHARED SOFTWARE  

While sharing the following types of shared software, you can let an attendee control it remotely: 
 Application 
 Desktop 
 Web browser 

An attendee who has remote control of shared software can interact with it completely. While an attendee is remotely 
controlling your shared software, your mouse pointer is inactive. At any time, however, you can reassume control of a shared 
application and regain use of your mouse pointer.  
While you are sharing software, any attendee can send a request to control the software remotely. You can then grant control 
to the attendee. Alternatively, you can automatically grant control of shared software to any attendee who requests remote 
control.  
You can stop an attendee from remotely controlling shared software at any time.  
To let an attendee remotely control shared software: 

1 Do either of the following: 
- On the title bar of a window that you are sharing, on the Sharing menu, point to Allow to Control Remotely.  

 
- In the lower-right corner of your computer’s desktop, on the Sharing menu, point to Allow to Control Remotely.  

 
2 Select the name of the attendee whom you want to control the software.  
 
  

 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sharing Your Desktop  
Desktop sharing lets you show all of your training session attendees your computer’s entire desktop—including any 
applications and windows that are currently open— and all the actions that you take with your desktop. Desktop sharing can 
be useful for technical support. For example, you can allow a technical support representative to access your computer and 
fix a problem as you watch.  
While sharing your desktop, you can: 

 Control attendees’ views of your desktop. 
 Annotate your desktop, using a highlighter tool. 
 Let an attendee control your desktop remotely. For example, you can let an attendee edit a document on your 
computer. 
 Let an attendee annotate your desktop remotely.  

To share your desktop:  
On the Share menu, choose Desktop.  
Your desktop appears in a sharing window on attendees' screens.  
To allow an attendee to control your desktop remotely: 

1 On the title bar of an application you are sharing, on the Sharing menu, point to Allow to Control Remotely. 
2 Select an attendee to control your desktop.  

Sharing a Remote Computer 
Remote computer sharing lets you show all your training session attendees the computer’s entire desktop or specific 
applications on it, depending on how you set up the remote computer, and all actions that you take with the computer.  
Remote computer sharing can be useful if you want to show attendees an application or file that is available only on that 
computer.  
You can share a remote computer during a training session for which you are the presenter, if:  

 You have installed the Access Anywhere Agent on the remote computer. 
 You logged in to your TrainingCentre Web site before joining the training session, if you are not the original training 
session host.  

For information about setting up a computer so you can access it remotely, refer to the Access Anywhere User’s Guide.  
To share a remote computer:  
If you have already set up a computer for Access Anywhere, you can share the computer during a training session. 

1 On the Share menu, choose Remote Computer. The Access Anywhere dialog box appears. 

 
2 Under Remote, select the computer that you want to share. 
3 Under Applications, select an application that want to share.  

If you set up the remote computer so you can access its entire desktop, the option Desktop appears under 
Applications. 

4 Click Connect. Depending on the method of authentication that you specified when setting up the computer for 
Access Anywhere, one of the following occurs: 

- If you chose access code authentication, a dialog box appears, in which you must provide the access code that you 
specified when setting up the remote computer. 

- If you chose phone authentication, you receive a phone call at the number that you specified when setting up the 
remote computer. 

5 Do one of the following: 
- If you chose access code authentication, type your access code in the box, and then click OK. 
- If you chose phone authentication, provide your pass code by following the voice instructions.  

NOTES :If you are not the original training session host, you must log in to your Training Center Web site before joining a training session in which you want to 
share a remote computer. If you are already in a training session, but did not log in to your site, you must leave the training session, log in to your site, and 
then rejoin the training session. 
If a password-protected screen saver is running on the remote computer, your training session service automatically closes it once you provide your access 
code or pass code. If the remote computer is running Windows 2000, and you must log in to the computer, send a Ctrl+Alt+Del command to the computer. 
If you set up the remote computer so you can access multiple applications, you can share additional applications simultaneously. 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips for Sharing Software  
These tips can help you share software more effectively: 

 To improve the readability of shared software, attendees can use the sizing options on the View menu. 
 To improve the quality of attendees' views of a shared software, ensure that both your monitor display and attendees' 
monitor displays are set to the same color depth for example, 16-bit color. 
 To improve the performance of software sharing, close all applications that you do not need to use or share. Also, 
close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive 
streaming audio or video from the Web. 
 Application and Web browser sharing only: Avoid covering a shared application or Web browser with another window 
on your computer's desktop. Doing so prevents attendees from viewing the area of the application or browser that the 
other window covers. Instead, a crosshatched pattern appears in the covered area on attendees' screens. 
 You can switch your display between shared software and the Meeting window. To conserve bandwidth, pause 
software sharing before you return to the Meeting window, and then resume sharing once you return to the shared 
application. 
 Use a dedicated, high-speed Internet connection when sharing software. Attendees using dial-up Internet connections 
may notice a delay in viewing or controlling shared software. If you want to share a Microsoft Word, Excel, or other 
document, you can improve the meeting experience for these attendees by using document sharing instead of 
application sharing.  

Transferring Files During a Training Session  
As a presenter, you can publish files that reside on your computer during a training session. For example, you can provide 
attendees with a document, a copy of your presentation, an application, and so on. Published files appear in each attendee’s 
Session window, allowing them to download the files to their computers.  

To transfer files during a training session: 

1 On the File menu, choose Transfer. The File Transfer window appears. 
2 Click Share File. 
3 Select the file that you want to publish, and then click Open. 
4 Optional. Repeat steps 2 and 3 to publish additional files. The files appear in the File Transfer window in each 

participant’s Session window  

Recording a Training Session  
For details about using WebEx Recorder to record on-screen activity in a training session and capture audio in a voice 
conference, refer to the WebEx Recorder and Player User’s Guide, which is available on Recording and Playback page on 
your TrainingCentre Web site. You can access this page from your site’s Support page. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Working with the panels  
Using the panels on the right side of the Session window, you can chat with attendees, poll them, send video. These panels 
are very flexible. You can expand, close, or minimise them quickly and easily. You can also reduce the panels to icons, 
providing greater space for sharing documents, applications, and other items with meeting participants.  

PANEL OVERVIEW  

Your service selects which panels display initially. 
 

To display the Select 
Panel menu, click 
Panels

The Video panel is 
collapsed. Use the icon 
on the left side of the 
panel title bar to 

You can minimize all 
the panels at once 
using the Minimize All 
command

In this example, the Q & A 
panel is minimized. Click 
Q & A in the icon tray to 
restore it

 

MINIMIZING AND RESTORING PANELS  

Minimizing and restoring panels has no effect on attendees’ displays.  

To minimise a panel:  

Click the Minimise icon on the title bar of the panel you want to minimise.

 
 

 Click the Minimise icon to 
minimise this panel  

 
 

 
 
 
 
 
 

 The panel no longer displays. It appears as an icon on the icon tray at the top of the panels. 

 
 
 

Minimised panels display as icons. 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 

To restore a minimised panel:  

Click its icon on the icon tray. 

 
 
 
 
 

Click to restore. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To minimise all panels:  
 

1 On the icon tray, click Panels.  
The Select Panel menu displays. 
2 On the Select Panel menu, choose Minimise All.  
The open panels shrink to icons on the icon tray. 

 

To restore all minimised panels:  
 
The Restore All command quickly restores all panels you have minimised using the Minimize All command. 

1 In the icon tray, click Panels.  
The Select Panel menu displays. 
2 On the Select Panels menu, choose Restore All.  
Minimised panels now display.  

EXPANDING AND COLLAPSING PANELS  

Expanding and collapsing panels has no effect on the attendees’ displays.  
To collapse a panel:  
Click the icon in the upper left corner of a panel to collapse it.  
The panel collapses, leaving just the title bar visible. 
Use the icon on the left side of the panel title bar to collapse or expand a panel.  
 
 
 
 
 
 
 

The Chat panel is 
collapsed 

 
 
 

 
 
 
 

To expand a panel:  
 
If a panel is collapsed (you only can see its title bar), click the icon in the left corner of the title bar to expand it.  

 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 

OPENING AND CLOSING PANELS  

You can hide a panel completely so it will not display as an icon on the icon tray. If you close a panel, that panel also closes 
for attendees. It remains closed for all attendees until you open the panel again.  
To close a panel: 
 

1 On the icon tray above the panels, click Panels.  
The Select Panel menu display 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 On the Select Panel menu, c
The panel no longer displays and
If you close the last remaining pa
access to the panels through the 

 

 
 

To open a panel:  
 

1 On the icon tray above the pa
The Select Panel menu displays.
2 On the Select Panel menu, c
The panel or panels you selected

RESETTING THE PANELS 

You can return the panels to the displ
 

1 On the icon tray above the pa
The Select Panel menu displays.
2 On the Select Panel menu, c

 
The panels return to the display settin
reset to their original settings. 

 
 
 
 
 
 

Panels without check marks 
are currently closed.
Panel with checkmarks 
currently display. 

lick to remove the check mark next to the panel you want to close.  
 it is not available as an icon on the icon bar.  
nel, the large panel area on the right side of the screen disappears. You still have 
Select Panel menu, available by clicking the Select Panel button. 

nels, click Panels.  
 
lick to place a check mark next to any panel you want to open.  
 display. This panel is now available for all attendees.  

ay settings that were preset by your service. 

nels, click Panels.  
 
hoose Reset to Default.  

gs originally selected by your service. The size, order, and location of the panels are 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ACCESSING PANEL OPTIONS  
You can easily access the options related to any panel. Simply right-click in the panel title bar to see a menu of commands 
related to the panel. 
Panel Options 
Participants Sound Alerts: Lets you choose a sound to play when a participant:  

 Joins a training session 
 Leaves a training session 

Assign Privileges: Available for only the training session host. Displays the Assign Privileges dialog 
box, from which you can set privileges for the attendees. 

Chat Sound Alerts: Lets you choose the kinds of chat messages for which you want a sound to play. Select 
a sound from the drop-down list or click Browse to find a sound in a different location on your 
computer.  
Assign Privileges: Available for only the training session host. Displays the Assign Privileges dialog 
box, from which you can set privileges for the attendees. 

Video Single point video: Lets you view one participant video image.  
Multi-point video: Lets you view up to four participant video images.  
Video Options: Lets you adjust the video frame rate, video resolution, and settings for your video 
capture device. 

RESIZING THE CONTENT VIEWER AND PANELS AREA  

You can control the size of the content viewer by making the panel area narrower or wider.  
 
To change the size of the content viewer and panels:  
 
Click the dividing line between the content viewer and the panels. 

 Drag the line to the left to make the area devoted to the panels wider. 
 Drag the line to the right to make the content viewer larger. 

 

 
Drag this line to the right or left to change the size of the content viewer and panels area 
 
For details about hiding, minimizing, and closing the panels, see Panels and full-screen view, next.  
 

 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Panels and Full-Screen View  
While you are viewing or remotely controlling a shared application, desktop, or Web browser, or viewing a shared remote 
computer, a presenter can switch between a standard window and full-screen view.  
 
In full-screen view, you access the panels on a floating icon tray located in the lower right corner of your screen. 

 

To display a panel in full-screen view:  
 
Click its icon on the floating icon tray. For example, to display the Chat panel, click the Chat icon.  
 
The panel “floats” on top of the shared document, presentation, web browser or other shared item. You can drag the panel to 
move it. 

 

 

To open all panels in full-screen view:  
 
You can have all panels float on top of the shared document, presentation, web browser, or other shared item. 
 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose Float All Panels. 
All panels display, even those you had minimized previously.  
 

What you can do  
Resize individual panels using the Resize Control in the bottom right corner of any floating panel. 

 

 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To organize the floating panels: 
 
As you reopen the panels to jot a few notes or chat with a participant, you may find you need to arrange the panels. 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose Open Right Panel.  
An empty panel appears on the right side of the screen.  
The icon tray now resides at the top of the right panel. 

 
What you can do  
Drag any floating panels into this larger panel. Panels resize to fill the space. 

 
 Drag the panel out of the larger panel to “float” it. 
 Switch between full-screen view and standard view.  

 
After you return to standard view, all panels (those that are floating and those that you have minimised) return to their preset 
locations in the right panel.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SHARING DOCUMENTS OR SOFTWARE WHILE IN FULL-SCREEN VIEW  

In full-screen view, you have access to sharing and viewing options from the Select Panel menu. 
 
If you are sharing a document  
 
If you have already opened several documents, you can switch to share any of these documents.  
 
To display a different document: 
 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose Share.  
You see a list of sharing commands. 

 

3 Select Presentation or Document.  
The Share Presentation or Document dialog box appears. 
4 Select the file that you want to share and click Open.  

To resize the display of attendees to match your display: 
 

1 On the icon tray above the panels, click the Select Panel button.  
It is the last button on the floating icon tray.  
2 On the Select Panel menu, choose View > Synchronize Views.  
All attendees’ displays now match your display.  

 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IF YOU ARE SHARING AN APPLICATION 

To share an application: 
 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose Share > Application.  
The Share Application dialog displays. 
3 Select the application you want to share or click New Application to open an application not already running on your 

desktop. 
4 Click Share.  

 
To resize the display of attendees to match your display: 
 

1 On the floating icon tray, click the Select Panel button. 
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose View > Synchronize Views.  
Synchronize Views command All attendees’ displays now match your display.  

IF YOU ARE SHARING A DESKTOP  

To select another sharing option: 
 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose Share > Desktop.  

 
To resize the display of attendees to match your display: 
 

1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
2 On the Select Panel menu, choose View > Synchronize Views.  
All attendees’ displays now match your display. 

Panel alerts  
If you have closed, minimized, or collapsed any panels, you will see an alert if a panel you no longer can see requires your 
attention.  
 
Some reasons for seeing alerts: 
 

 A participant arrives or leaves a training session 
 A Raise Hand indicator appears in the Participants list 
 An attendee sends a chat message 
 A poll opens or closes 
 Poll answers are received  

 
 

 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ALERTS FOR CLOSED PANELS  
If you have closed a panel, the Panels button changes color to alert you to a change. For example, if a participant leaves 
your training session, and you have closed the Participants panel, the Select Panel menu button turns into an alert. 

 

ALERTS FOR MINIMIZED PANELS  

If you have minimized a panel, the icon representing that panel alerts you of a change. 

 

ALERTS FOR COLLAPSED PANELS  

If you have collapsed a panel, the Expand/Collapse icon changes color when you need to pay attention to that panel. 

 

Understanding the Participants Panel 
In addition to the list of people currently attending your training session, the Participants panel provides other 
information about the attendees. 

 

 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following table describes the possible indicators that may appear in the participant list. 
Indicator Indicator Name Description 
(host) Host indicator Indicates the training session host. 

 Presenter indicator Indicates the current presenter. 

  

Annotation Colour indicator Indicates the color with which the participant can annotate shared 
content. Participants can select another color with which to make 
annotations, but their assigned colors in the participant list remain 
the same 

 

Participant Ready indicator Indicates that the participant’s content viewer is displaying the page, 
slide, or whiteboard that the presenter is sharing. Can appear in 
different states, each of which indicates the percentage of the 
content that has loaded in the participant's content viewer. 

 
Speaker indicator for teleconference In an integrated teleconference, indicates that the participant is 

connected to the teleconference and his or her microphone is not 
muted—that is, the participant can speak. 

 
Muted Speaker indicator for 
teleconference 

In an integrated teleconference, indicates that the participant is 
connected to the teleconference but his or her microphone is muted. 

 
Ask to Speak indicator In the host’s and presenter's participant list only, indicates that the 

participant has clicked the Raise Hand button. 

Sending a chat message to participants  
Chat is useful if you want to: 
 

 Communicate with a participant during a training session that does not include a voice conference 
 Send a private message to another participant 
 Send brief information to all participants 
 Ask a question but do not want to interrupt the presenter  

 
To send a chat message:  
 

1 In the Session window, open the Chat panel. 
2 Type a message in the Chat box. 
3 In the Send to drop-down list, select the recipients of the message. 

 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using the Q & A Panel  
During a question-and-answer (Q & A) session, you can respond to questions that attendees ask during the training session. 
A Q & A session not only provides instant text messaging similar to that in Chat, but also does the following: 
 

 provides a more formal procedure for asking and answering questions in text format 
 automatically groups questions to help you manage the queue, such as quickly identifying questions that you have or 
have not answered 
 displays visual cues for the status of questions 
 lets you assign questions to the appropriate domain expert on your team  
 allows you to quickly send a standard response to questions for which you cannot or do not want to answer 
immediately You can save the questions and answers in a Q & A session to either a text (.txt) file or a comma-
separated/comma-delimited values (.csv) file for future reference.  

 
Tip: If you use Q & A during the training session, WebEx recommends that the host or presenter monitor the Q & A panel at all times during the training 
session.  

ALLOWING PARTICIPANTS TO USE Q & A SESSIONS  

You can allow or prevent training session participants from using question-and-answer (Q & A) sessions during a training 
session.  
 
To allow or prevent Q & A sessions: 
 

1 In the Session window, on the Session menu, choose Session Options.  
 
The Training Session Options dialog box appears.  

 
 

2 On the Communications tab, do one of the following: 
To allow participants to use Q & A sessions, select the Q & A check box. 
To prevent participants from using Q & A sessions, clear the Q & A check box. 

3 Click Apply, and then click OK.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ASKING A QUESTION  

You can pose a question to one respondent or selected respondents.  
 
To ask a question: 
 

1 In the Session window, in the Panels drop-down list, select Q & A. 
 

 
 

2 Type your question in the Q & A box. 
3 Optional. To edit your question before sending it, highlight the text and then right-click the mouse to see editing 

options. 
4 In the Ask drop-down list, select the recipients. 
5 Click Send.  
The recipients receive the question in their Q & A message boxes. 

ANSWERING INDICATOR 

When a panelist is typing an answer to a question that no one else has responded to yet, an in-progress indicator displays 
under that question:  
 

 

ANSWERING A QUESTION  

You can answer a question in one of the following ways: 
 

 publicly—the answer appears for all panelists and attendees. 
 privately—the answer is sent to all panelists and to the attendee who sent you the question.  

 

 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To answer a question: 
1 In the Session window, in the Panels list, select Q & A. 
2 Select the question from any of the tabs on which you received the question. For example:  

 

3 Do one of the following: 
- To provide a public answer, type your answer in the text box. To edit your answer before sending it, highlight the text 

and then right-click the mouse to see editing options. 
- To provide a private answer, click Send Privately. In the dialog that appears, type your answer in the text box. If you 

want to save the answer you typed as the standard private answer for all panelists, click Save. 
4 Click Send.  

Using Hands-on Lab  
Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers 
on which training software is installed. Students can use these remote computers during a training session for hands-on 
learning and practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab 
environment that is effective, familiar, and consistent. 

STARTING A HANDS-ON LAB SESSION  

If you have scheduled a Hands-on Lab, you can start the Hands-on Lab session within 15 minutes of the reserved time. The 
presenter is responsible for managing the Hands-on Lab session.  
To start a Hands-on Lab session: 

1 In the Session window, on the Lab menu, click Start Hands-on Lab. The Start Hands-on Lab dialog box appears 
showing which lab and how many computers are reserved. 

 
Note: If you try to start the Hands-on Lab session earlier than 15 minutes before the scheduled reserved time, an error message appears informing you to start 
the Hands-on Lab session during the reserved time. 
 

2 Under Computer Allocation, select one of the following: 
- Allow attendees to choose computers. This allows participants to choose any computer reserved for this session. 
- Assign attendees to computers manually. When you select this option, participants can only connect to computers 

assigned to them. 
3 Optional. Select the Record remote computers automatically when participants connect check box. When you select 

this option, the Record button turns on for all reserved computers. Whenever a participant logs into a reserved 
computer, the computer records the actions. When the participant logs out, the recording stops. 

4 Click Start.  
Training Manager contacts the remote computers reserved for your Hands-on Lab session.  
Once the reserved computers are contacted, the Start Hands-on Lab Confirmation dialog box appears.  
The Start Hands-on Lab Confirmation dialog box lists all the computers that are connected to the session and the total 
attendees in the session. 
5 Optional. To limit the number of attendees that can connect to each remote computer, under Limit Attendees, select 

the check box next to Limit. Select the number of attendees that you want to limit to each computer. 
6 If you selected Assign attendees to computers manually in the Start Hands-on Lab dialog box, see To assign 

computers to participants during a Hands-on Lab session: below. 
7 Click Done.  



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ASSIGNING COMPUTERS DURING HANDS-ON LAB SESSIONS  

If you selected Assign attendees to computers manually in the Start Hands-on Lab dialog box, you can assign computers to 
participants from the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the Lab menu.  
 
To assign computers to participants during a Hands-on Lab session: 
 

1 From the Start Hands-On Lab Confirmation dialog box, from the Hands-on Lab panel, or from the Session window 
Lab menu, click Assign Computers.  

The Assign Computers dialog box appears.  

 

2 Under Unassigned Participants, select the name or names of participants that you want to assign to a particular 
computer. Hold down the Shift key to select more than one participant. 

3 Under Computers, select the computer that you want to assign to the selected participant. 
4 Click Assign. 
5 To give control of the computer to a particular participant, click Give Control. 
6 When you are finished assigning computers, click OK. 
7 Click Done in the Start Hands-on Lab Confirmation dialog box.  

ASKING ALL TO RETURN FROM LABS  

During a Hands-on Lab session, the host can ask all the participants to return from the Hands-on Lab session to the main 
training session. You can choose to have the participants return immediately, or you can give them a time limit for returning.  
 
To ask participants to return: 

1 On the Lab menu, choose Ask All To Return.  
The Ask All To Return dialog box appears.  

 
2 Do either of the following: 

- Select within and choose a time in minutes from the drop-down list. This option gives participants time to finish the 
tasks that they are working on. 

- Select immediately and end all sessions after 30 seconds. 
3 Click OK.  
A confirmation dialog box appears in which you confirm your request to ask all participants to return from Hands-on Lab. 
4 Click OK.  
All participants receive a message asking them to return from Hands-on Lab. The Hands-on Lab sessions end either 
after 30 seconds or after the time you selected in the Ask All To Return dialog box.  

 

 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ENDING THE HANDS-ON LAB SESSION  

The training session host can end the Hands-on Lab sessions at any time.  
 
To end a Hands-on Lab session: 
 

1 On the Lab menu, click End Hands-on Lab. A confirmation message appears. 
Click OK. The Hands-on Lab session ends for all participants.  

Note: If you do not manually end the Hands-on Lab sessions, they end automatically when your reservation for Hands-on Lab computers expires. A message 
appears on your screen 15 minutes before your reservation expires. If the computers have not been reserved for another training session, you can continue to 
connect to the Hands-on Lab computers. If the host of the new session attempts to connect to the reserved computers, you will be disconnected from the 
reserved computers.  

Using Breakout Sessions  
A breakout session is a private content sharing session that includes two or more participants. Breakout sessions allow 
participants to brainstorm and collaborate in small, private groups that can include presenters or other students, away from 
the main training session. In a breakout session, small groups interact within a main Breakout Session window using much of 
the same features, such as sharing whiteboards and applications, as in the main training session. Multiple breakout sessions 
can occur at once. 

ALLOWING BREAKOUT SESSIONS  

As a presenter, you can allow panelists or participants to start their own breakout sessions.  
 
To allow breakout sessions:  
Do one of the following: 

 In the Session window, on the Breakout menu, choose Allow Breakout Sessions.  

 

 On the Breakout Sessions panel, select Allow Breakout Sessions.  

 

 In the Session window, on the Session menu, choose Session Options. On the Communications tab in the Training 
Session Options dialog box, select Breakout sessions. Then click OK.  

The green indicator on the Breakout Sessions panel indicates that breakout sessions are allowed.  
The Breakout menu displays the breakout session options for all participants.  

 

 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CREATING A BREAKOUT SESSION  

Once the presenter allows breakout sessions, you can create your own session.  
 
To create a breakout session: 
 

1 Do either of the following: 
- On the Breakout menu, point to Create Breakout Session. 
- On the Breakout Session panel in the main Session window, click Create Session.  
The Create Breakout Session dialog box appears.  

 
2 In the Topic box, type a topic name.  
Optional for the host, presenter, and panelists only: To include yourself in the breakout session, select the Include myself 
into this session check box. 
3 Under Participants, select the check box next to the participants that you would like to invite to the breakout session.
4 In the Presenter drop-down list, select Myself or the name of the participant whom you want to be the presenter for 

the session. 
5 Optional. To allow participants to join the breakout session without an invitation, under Participants, select the check 

box next to Let others join the breakout session without invitation. 
6 Optional. To limit the number of participants for the breakout session, under Participants, select the check box next 

to Limit number of participants who can join this session. Then, in the box, type or select a number of participants. 
7 Click Create.  

 
Your breakout session automatically starts, and each invitee receives an invitation to join. The invitee can choose Yes or 
No. For breakout session participants, the Breakout Session window appears, listing the names of the presenter and 
participants of the breakout session in the Breakout Sessions panel. It also displays a chat panel in which participants 
can chat with other participants. Your name appears in the Breakout Sessions pane in the main Session window.  

JOINING A BREAKOUT SESSION  

The presenter determines whether a participant can join a breakout session, either by inviting participants, or by allowing 
participants to join without an invitation.  
 
To join a breakout session, do one of the following: 
 

 On the Breakout menu, choose Join Breakout Session and then the name of the breakout session that you wish to 
join. 
 On the Breakout Session panel, highlight the name of the breakout session that you wish to join and then click Join 
Session.  

Using Integrated VoIP or teleconferencing in breakout sessions  
You can communicate with breakout session participants using Integrated VoIP or teleconferencing. If teleconferencing is set 
up in the main training session, when you start a breakout session, the call-in or call-back teleconference automatically starts 
for the breakout session. All the teleconferencing options or Integrated VoIP options that the host set up in the main session 
apply to the breakout sessions. For more information on Integrated VoIP or teleconferencing, see About managing a voice 
conference.  
 

 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 Participants in a breakout session cannot join a breakout session teleconference until the breakout session presenter 
joins the teleconference. 
 Participants cannot join a teleconference in the main session while connected to a breakout session teleconference. 
 If teleconferencing is not available or has not been started for the main session before the breakout session is started, 
teleconferencing for breakout sessions is disabled also. 
 When a participant who is in the breakout session teleconference leaves a breakout session, he or she disconnects 
from the breakout session teleconference or Integrated VoIP session automatically. The participant returns to the main 
session and can join the main teleconference or Integrated VoIP session from the Communicate menu. 

LEAVING A BREAKOUT SESSION  

If you are a participant in a breakout session, rather than the presenter, you can leave a session and return to it later.  
To leave a breakout session, do one of the following: 

 Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window. 
 On the File menu, choose Leave Breakout Session. 
 On the Breakout Session panel, click Return to Main Session.  

ASKING ALL PARTICIPANTS TO RETURN FROM A BREAKOUT SESSION  

As the presenter, you can ask panelists and participants to return from their breakout sessions.  
To ask all to return from breakout sessions: 
In the Session window, on the Breakout menu, choose Ask All to Return.  
All participants in breakout sessions receive a message asking them to return to the main training session. They can choose 
to leave the session or continue.  

ENDING YOUR BREAKOUT SESSION  

If you are the presenter in a breakout session, you can end your session for all participants.  
To end a breakout session: 

1 Do one of the following: 
- Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window. 
- On the File menu in the Breakout session window, choose End Breakout session. 
- On the Breakout Sessions panel in the main Session window, click End Breakout Session. 

2 In the dialog box that appears, click Yes. 

Setting Up Video  
If a video camera is attached to your computer, you can send live video to training session participants. Live video lets other 
participants see you, an object under discussion, and so on. All participants can view live video that you send, without the 
need for video equipment installed on their computers.  

To set up video, you must connect a video camera—also called a webcam— to your computer. Once you start or join a 
training session, Training Manager automatically detects your video camera.  

Generally, Training Manager is compatible with any video camera that connects to your computer's USB or parallel port. The 
quality of the video image can vary, depending on the quality of the video camera that you use. For a list of video cameras 
that are known to be compatible with your Training Manager software, refer to the Frequently Asked Questions (FAQ) page 
on your TrainingCentre web site. You can access this page from your site’s Support page.  

 

 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SENDING LIVE VIDEO  

If the single-point video option is turned on, only the presenter or another participant selected by the presenter can send live 
video.  
If the multipoint video option is turned on, up to four participants whose computers have a video camera can send video. 
Only the presenter or another participant selected by the presenter can send live video. 
To send live video: 
In the Session window, display the Video panel on the right side of the Session window. For details about using the panels, 
see Working with the panels.  
Training Manager begins sending live video immediately. To send live video, you must connect a video camera to your 
computer.  
For details, see consult the documentation that accompanied your camera.  

Polling Attendees  
During a training session, you can poll attendees by providing a questionnaire with multiple-choice answers. Taking a poll 
can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, testing attendees' knowledge 
of a topic, and so on.  
To take a poll, you must first prepare a poll questionnaire. You can prepare a questionnaire at any time during a training 
session. Or, to save time during a training session, you can prepare a questionnaire before the training session starts, save 
it, and then open it during the training session.  
Once attendees complete a poll, you can view the results and share them with attendees. You can also save the results of a 
poll for viewing outside of a training session.  

PREPARING A POLL QUESTIONNAIRE  

During a training session, you can prepare a poll questionnaire that includes multiple-choice answers. Once you complete a 
questionnaire, attendees can respond to it during a training session. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Participant Roles and Privileges  
Each participant in an online training session has one of the following roles: host, presenter, panelist, or attendee. These 
roles determine which options you can use on your TrainingCentre Web site and in Training Manager. 

Role Responsibilities and options 
Host A training session host must have a user account on your TrainingCentre Web site. A host can 

schedule, start, and control a training session; and assign training session roles to other 
participants. Initially, the host is also the presenter; however, the host can make any participant the 
presenter during the training session. 

Presenter Only one participant at a time can be the presenter, but participants can take turns being the 
presenter during a training session. A presenter can: 

 Share and annotate presentations, documents, and whiteboards 
 Share software, and grant remote control of shared software to participants 
 Assign training session privileges to other participants 
 Turn various training session options on or off 
 Poll participants 
 Transfer files to participants 
 Send live video, and select which participants can send video 

Panelist An attendee who participates in a discussion to which other attendees listen, responds to chat 
messages, annotates shared documents, opens and closes polls, and views and answers 
attendees’ questions in Q & A sessions. 

Attendee A training session attendee participates in a training session but generally does not present 
information. Attendees can view shared information and interact with it, if the presenter assigns the 
appropriate privileges to them. An attendee can also perform other tasks, such as recording a 
training session, if he or she has the appropriate privileges 

About Granting Privileges to Attendees  
Once a training session starts, all training session attendees automatically receive privileges: 
 

 If the host scheduled the training session and specified attendee privileges, attendees receive those privileges. 
 If the host scheduled the training session but did not specify attendee privileges, attendees receive the default 
privileges. 
 If the host started an instant training session, attendees receive the default privileges.  

 
You can grant or remove privileges for the following training session activities: 
 

 Document sharing, including privileges for saving, printing, and annotating shared content in the content viewer 
 Viewing thumbnails, or miniatures, of pages, slides, or whiteboards in the content viewer 
 Viewing any page, slide, or whiteboard in the content viewer, regardless of the content that the presenter is viewing 
 Viewing the participant list 
 Chatting with participants 
 Allowing breakout sessions with participants 
 Recording a training session 
 Requesting remote control of shared applications, desktops, or Web browsers  

 
 
 
 
 
 
 
 
 
 
 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Granting Attendee Privileges During a Training Session  
During a training session, you can grant privileges to or remove them from all attendees at once or an individual attendee.  
To specify attendee privileges during a training session: 

1 In the Session window, do one of the following: 
- On the Participant menu, choose Assign Privileges. 
- On the Participant panel, right-click a participant’s name, and select Assign Privileges.  
The Assign Privileges dialog box appears. 

2 Specify attendee privileges: 
- To grant a privilege to attendees, select its check box.  
- To grant all privileges to attendees, select the All attendee privileges check box. 
- To remove a privilege from attendees, clear its check box. 

3 Click OK. 

Controlling a training session  
As a training session host, you can control many aspects of an online training session.  

INVITING ATTENDEES TO A TRAINING SESSION IN PROGRESS  

Once you start a training session, you can invite additional attendees to the training session, as well as remind those who you 
invited, but haven’t yet joined. Each person that you invite receives either an invitation email message or instant message that 
includes information about the training session— including the password—and a link that the attendee can click to join the 
training session.  
To remind or invite an attendee to a training session in progress: 

1 On the Participant menu or from the Invite or Remind participants button on the Participant panel, do one of the 
following: 

- Point to Remind, choose by Email, and then choose either to send via the session email or from your local email 
program. 

- Point to Remind, choose by IM, and select a WebEx AIM Pro contact. You can also copy the session information into 
another IM program. 
Point to Invite, choose by Email, and then choose either to send via the session email or from your local email 
program. 

- Point to Invite, choose by IM, and select a WebEx AIM Pro contact. You can also copy the session information into 
another IM program. 

2 Type the attendee’s screen name or email address. 
3 Click the appropriate button to send the reminder or invitation.  

DESIGNATING A PRESENTER  

As a training session host, you are initially the presenter as well. However, you can designate any attendee as the presenter. 
You can also reclaim the presenter role or change the presenter at any time.  
To designate a presenter: 

1 In the Participants panel, select the name of the attendee whom you want to designate as the presenter. 
2 Do one of the following: 

- On the Participants panel, click Make Presenter. 
- Right-click the attendee’s name, select Change Role To, and then Presenter. 
- On the Participant menu, select Change Role To, and then Presenter.  

TRANSFERRING THE HOST ROLE  

As a training session host, you can transfer the host role—and thus all control of the training session—to an attendee.  
To transfer the host role: 

1 In the Participants panel, select the name of the attendee to whom you want to transfer the host role. 
2 Do one of the following: 

- Right-click on the participant’s name, select Change Role To, and then Host. 
- On the Participant menu, select Change Role To, and then Host.  

 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

EXPELLING A PARTICIPANT 

You can remove, or expel, a participant from a training session at any time.  
To expel a participant: 

1 In the Participants panel, select the name of the participant whom you want to expel. 
2 On the Participant menu, select Expel. 

LOCKING AND UNLOCKING A TRAINING SESSION  
Once you start a training session, you can restrict access to it, or “lock” it. This option prevents anyone else from joining the 
training session. You can unlock a training session at any time.  
To lock a training session:  
On the Session menu, choose Restrict Access.  
To unlock a training session:  
On the Session menu, choose Restore Access.  

ENDING A TRAINING SESSION  

Once you end a training session, the Session window closes on all participants’ screens. If the training session includes an 
integrated voice teleconference, the conference also ends.  
To end a training session: 

1 On the File menu, choose End Training Session. 
2 In the confirmation message that appears, click Yes.  

VIEWING USAGE REPORTS  

If your Training Center Web site includes the reports option, you can view the following types of usage reports: 
 Live Training Usage report—Contains detailed information about each training session that you host, including 
information about each participant. 
 Access Anywhere Usage report—Contains detailed information about the computers that you access remotely and 
your Access Anywhere sessions, if your site or account includes the Access Anywhere option. 
 Recorded Training Access report—Contains detailed access information about recorded training sessions on your 
Training Center Web site. This report includes information for each time your recorded session is viewed.  

To view a usage report: 
1 Log in to your Training Center Web site. 
2 On the navigation bar, click My WebEx. 
3 Click My Reports. 
4 Select the type of report that you want to view. 
5 Specify a range of dates for which you want to view a report and how you want data sorted in the report. 
6 Click Display Report. 

Contacting WebEx Communications  

RECEIVING TECHNICAL SUPPORT  

For information about contacting technical support for InterCall WebEx TrainingCentre, refer to the Support page on your 
Training Centre Web site.  
 

 
 


